
0 5 1 4 5 6 2 1 - 0 0 5 A  F e b r u a r y  1 9 9 8 
2727 Kurtz Street, San Diego, California 92110
1-800-335-8321 • (619) 291-4211 • Fax: (619) 291-2584
E-mail: info@email.exide.com
URL: http://www.exide.com
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P o w e r  M a n a g e m e n t  S o f t w a r e 

U s e r  M a n u a l 



S E C T I O N  1 

LANSAFE III AND FAILSAFE III
FOR DATA PROTECTION

FailSafe III for standalone computer systems and LanSafe III for network systems are
power management software programs. While you create a protected power
environment when you add an uninterruptible power system (UPS) to your system,
power management software gives you powerful monitoring and control
capabilities.

The primary goal of power management software is the protection of your computer
data. If a power event occurs that requires a system shutdown, the UPS provides
power, in place of utility power. If no one intervenes, this continues either until the
UPS is exhausted or the power management software conducts an orderly system
shutdown as it was programmed to do.

You can use your power management software to monitor your power situation
including the amount of available battery power, and you can use it to control the
length of shutdown time so the system stays up until data can be saved. Other
monitoring features include a Power Log, a Battery Management Log, and a Periodic
Log.



Alert response features program your software system to perform such tasks as
executing a specific command and sending a string to a modem if a given alert is
received. You can also change message text, for example, to another language if
necessary.

If your UPS supports load shedding, you can divide your load into segments with
different shutdown and restart sequences to extend battery runtime for your most
critical devices.

System administrators dealing with large computer networks can perform LanSafe
III control functions over all systems in their networks or domains without leaving
their desks.



N e w  Fe a t u r e s  f o r  Ve r s i o n  4

FailSafe III and LanSafe III version 4 expand the functionality of your power
management software. A Periodic Log for both FailSafe III and LanSafe III brings
new logging and graphing capabilities to the system. LanSafe III now becomes usable
in heterogeneous networking environments with the addition of a high level of
support for TCP/IP, SNMP, and NetFinity.

Version 4 is Year 2000 Compliant.

FailSafe III for Windows 3.x and LanSafe III for Windows 3.x do not support these
features.



P e r i o d i c  L o g  f o r  F a i l S a f e  I I I  a n d  L a n S a f e  I I I 

The Periodic Log provides users and customer support personnel with a new
diagnostic tool which will help analyze power problems. The log provides
information concerning input and output voltage, output frequency, load in watts,
and battery volts for specific dates and times.



T C P / I P  S u p p o r t  f o r  L a n S a f e  I I I 

TCP/IP is actually a suite of programs and functionality originally implemented on
the UNIX operation system. Its versatility and expansion of the Internet have led to
its implementation on every popular computing platform. Over the past several
years, it has become the de facto standard for network communication, often
replacing a platform’s native networking protocol in popularity and preference.

As a LanSafe III user, you are able to monitor the UPS functions via the LanSafe III
Console on a variety of different computers running vastly different operating
systems simultaneously. For example, you can view UPS operations from a UNIX
LanSafe III Console on computers running the LanSafe III Power Monitor on
Windows NT, OS/2, and Netware, and for the many UNIX operating systems
LanSafe III supports.

The implementation of the TCP/IP protocol into LanSafe III makes this possible.
Similarly, the implementation of TCP/IP in all LanSafe III Power Monitors enables
you to install UPS Groups consisting of multiple disparate operating systems. Thus,
you could have a NetWare server, a UNIX workstations, and a Windows 95 desktop
system all as part of the same UPS Group on a single UPS.



S N M P  S u p p o r t  f o r  L a n S a f e  I I I 

LanSafe III v.4.0 includes a simple network management protocol (SNMP) agent for
use with SNMP network management software programs.

The LanSafe III SNMP Agent acts as a server providing requested information,
obtained from the LanSafe III Power Monitor, about the computing product and
sending unsolicited alerts or traps about network conditions of interest.



N e t F i n i t y  S u p p o r t  f o r  L a n S a f e  I I I 

NetFinity is a non-SNMP based network management product from IBM. Its
primary function is to gather and process alert information from around the
network. LanSafe III adds the ability for LanSafe III Power Monitors to generate UPS-
related alerts to a NetFinity system running on the network. The generation of
NetFinity alerts is enabled and disabled for each LanSafe III alert by means of the
Customizable Alerts dialog box in the LanSafe III Console.



S E C T I O N  2 

INSTALLATION
Before you install your power management software, be sure your system meets the
appropriate requirements. Then follow the general installation procedure.



S y s t e m  R e q u i r e m e n t s 

All systems require the following:

• A UPS ready for RS-232 serial communication

• A dedicated RS-232 serial port for the UPS

• A second RS-232 serial port if the modem feature is used

• The correct cable for communication between your UPS and your computer

If you install an HP-UX Model 800, you need a gender bender, a null modem
adapter, the supplied cable, and a 9-25 adapter.

All UNIX systems must have 3 to 5 MB of available disk space. Requirements for
other systems are as noted below.

See the tables of supported operating systems and protocols. If installing LanSafe III,
see the Installation Guidelines for LanSafe III.



I n s t a l l a t i o n  G u i d e l i n e s  f o r  La n S a f e  I I I 

• In a network system, you must install at least one network protocol

• SNMP protocol is optional, but must be installed if the LanSafe III SNMP
Agent is used

• LanSafe III SNMP agent support is included for Windows NT (3.51+),
Windows 95, OS/2 (2.1+), NetWare (3.12+), IBM AIX (4.1+), HP-UX (9.x and
10.x), Sun Solaris (2.x+), SCO Open Server 5, and SCO UnixWare (2.x)



Supported Operating Systems and Protocols
Novell-DOS-Windows-OS/2-Macintosh

Product Operating System (Platform) Protocol(s) Supported
FailSafe III OS/2 2.0 and above (Intel 386/486/Pentium) N/A
FailSafe III Windows 3.1 (Intel 386/486/Pentium) N/A
FailSafe III Windows NT 3.5x or 4.0 (Intel and Alpha) N/A
FailSafe III Windows 95 (Intel 386/486/Pentium) N/A
LanSafe III OS/2 2.0, 2.1, 3.0 (WARP) and above (Intel

386/486/Pentium)
TCP/IP 2.0 and above, and/or LanServer 3.0
(server or requester) and above (NetBIOS)

LanSafe III Windows NT 3.5x or 4.0 with network services
installed; administrator privileges (Intel and Alpha)

NetBEUI and/or TCP/IP

LanSafe III Windows 4.0 (Intel 386/486/Pentium) NetBEUI, IPX/SPX, and/or TCP/IP
LanSafe III Windows 3.1x (IBM PC/AT/386/486) IPX via IPXODI.COM
LanSafe III DOS v.3.3 to 6.2x (IBM PC/AT/386/486) IPX via IPXODI.COM
LanSafe III Novell NetWare 386 3.10 or above; write access

to sys:\system directory (Intel 386/486/Pentium)
IPX and/or TCP/IP (on Netware 3.12+)

LanSafe III Macintosh System 7.x (Mac 680xx or PowerPC) Novell Client and/or AppleShare

NOTE 1: In a network system, you must install at least one network protocol.
NOTE 2: SNMP protocol is optional, but must be installed if LanSafe III SNMP Agent is used.
NOTE 3: LanSafe III SNMP agent support included for Windows NT (3.51+), Windows 95, OS/2 (2.1+),
NetWare (3.12+), IBM AIX (4.1+), HP-UX (9.x and 10.x), Sun Solaris (2.x+), SCO Open Server 5, and SCO
UnixWare (2.x)



Supported Operating Systems and
Protocols UNIX Systems

Product Operating System (Platform) Protocol(s) Supported
LanSafe III AT&T SVR4 UNIX 3.0+ (Intel 386/486/Pentium) TCP/IP
LanSafe III DEC UNIX 4.0+ (Alpha) TCP/IP
LanSafe III HP-UX 9.0.7+ (Alpha)

NOTE: For the LanSafe III SNMP Agent, the following is required: For
HP-UX 9.x, HP Extensible SNMP Agent v.3 or above; for HP-UX 10.x,
HP Extensible SNMP Agent v.4

TCP/IP

LanSafe III IBM AIX 3.2.0+ (RS/6000) TCP/IP
LanSafe III Interactive 3.0.1+ (Intel 386/486/Pentium) TCP/IP
LanSafe III Linux with kernel 2.x.x (Intel 386/486/Pentium) TCP/IP
LanSafe III SCO OpenServer 3.x and 5.x (Intel 386/486/Pentium) TCP/IP
LanSafe III Solaris 1.1+ (SPARC)

NOTE: For the LanSafe III SNMP Agent, the following is required: For
Solaris 2.x and 3+, HP Extensible SNMP Agent for Solaris v.4

TCP/IP

LanSafe III SunOS 4.1.1+ (SPARC) TCP/IP
LanSafe III UnixWare 2.0, Enhanced Communication (UPS Code II) UPSs only

(Intel 386/486/Pentium)
TCP/IP

NOTE 1: In a network system, you must install at least one network protocol.
NOTE 2: SNMP protocol is optional, but must be installed if LanSafe III SNMP Agent is used.
NOTE 3: LanSafe III SNMP agent support included for Windows NT (3.51+), Windows 95, OS/2 (2.1+),
NetWare (3.12+), IBM AIX (4.1+), HP-UX (9.x and 10.x), Sun Solaris (2.x+), SCO Open Server 5, and SCO
UnixWare (2.x)



G e n e r a l  In s t a l l a t i o n  Pr o c e d u r e s 

Before installation: UNIX users: Log in as root user. Novell Management System
users: Log on as supervisor. Windows NT network users: Log on as administrator.
Be sure a UPS has been installed and is running.

If installing LanSafe III in a SCO UNIX or UnixWare system with a UPS with dry-
contact interfaces, see the section below.

1. All users: Insert the compact disk into your computer’s CD-ROM drive.



2. UNIX users, skip to “Step 2 if Installing for LanSafe III for UNIX.” All others:
Navigate to the folder for the type of computer you wish to install and run the
install program, using the following table as a guide:

Type of computer to install Use CD install program
DOS workstation (network) Lansafe\Dos&Win\Install.exe
NetWare server Lansafe\Netware\Ls3setup.nlm
Win 3.1x workstation (network) Lansafe\Dos&Win\Setup.exe
Win 3.1x workstation (standalone) Failsafe\Win3x\Setup.exe
Win 95, NetWare network workstation Lansafe\Ntand95\Setup.exe
Win 95 workstation (standalone) Failsafe\Ntand95\Setup.exe
Win 95, NT network workstation LanSafe\Ntand95\Setup.exe
Win NT workstation (standalone) Failsafe\Ntand95\Setup.exe
Win NT workstation/server (network) Lansafe\Ntand95\Setup.exe
Win NT workstation/server (standalone) Failsafe\Ntand95\Setup.exe
Win NT DEC Alpha workstation/server (network) Lansafe\Ntalpha\setup.exe
Win NT DEC Alpha workstation/server (standalone) Failsafe\Ntalpha\setup.exe
OS/2 requester/server (network) Lansafe\os2\install.exe
OS/2 workstation (standalone) Failsafe\os2\install.exe



S t e p  2  i f  I n s t a l l i n g  L a n S a f e  I I I  f o r  U N I X 

As root, mount the CD-ROM at the mount point /cdrom, setting the options for
read only, file names are not converted, and default file permission 0500 (execute
permission to owner). Use the following table as a guide, or see man page of mount.

System LanSafe III for UNIX CD-ROM Mount Commands
AIX3 mount -v cdrfs -r /dev/cd0 /cdrom
AIX4 mount -v cdrfs -r /dev/cd0 /cdrom
DEC mount -r /dev/rz4c /cdrom
HP-UX 9 mount -r -t cdfs /dev/dsk/c201d2s0 /cdrom
HP-UX 10 /etc/mount -F cdfs -o ro /dev/dsk/c0t2d0 /cdrom
Interactive mount -r -f cdfs /dav/cd0/cdrom
Linux mount -r -o check=r /dev/cdrom /cdrom
SCO3 mount -r -f HS /dev/cd0/cdrom
SCO5 mount -r -f HS /dev/cd0/cdrom
Solaris mount -F hsfs /dev/dsk/c0t6d0s0 /cdrom (*)
SunOS mount -rt hsfs /dev/sr0 /cdrom
SVR4 mount -F cdfs -o ro,nmconv=c,fperm=0500 /dev/cd0 /cdrom
UnixWare2 mount -F cdfs -r -o nmconv=r /dev/cdrom/c0b0t2l0 /cdrom

(*)In a Solaris system, the Volume Manager daemon vold (e.g.
/cdrom/lansafe400) mounts the CD-ROM automatically if it is running.



a) Change to the directory where the CD-ROM is mounted.

b) Type ./install.sh to run the installation software (case depends on your
UNIX system).



T o  I n s t a l l  L a n S a f e  I I I  f o r  S C O ,  I n t e r a c t i v e ,  o r 
U n i x W a r e  w i t h  D r y - C o n t a c t  U P S s 

1. Back up your files before you install.

2. Be sure that other users are not logged on to the system through remote
terminals.

3. Never interrupt an installation.

4. Do not run background processes during installation if a system reboot could
adversely affect these processes, or if the processes would use free disk space
during a reconfiguration.

5. Follow the General Installation procedure above.



I n s t a l l  t h e  D e v i c e  D r i v e r  P r o m p t 

If you install LanSafe III in a SCO, Interactive, or UnixWare system using a UPS
with a dry contact interface, an “Install the device driver” prompt appears after the
end of regular installation. Choose y to rebuild the kernel or n to exit.

If you choose y, the kernel is rebuilt, completing installation and configuration of
LanSafe III. If you choose n, the system reminds you that you must install the device
driver later.

The Relay Contact UPS driver shares I/O addresses with the system serial device
driver (asy, sio, or asyc). The device install fails if the system serial device is not
configured to share its I/O address. If this happens, either modify the system file for
the serial device so that the port the UPS uses is disabled, or modify the master file
so the default serial device can share I/O devices. Check your system documentation
for information about disabling the pre-installed serial device.

When the kernel is rebuilt, the /dev/ups0 and /dev/ups1 device drivers become
available. Use these device drivers and not the standard UNIX device drivers
(/dev/tty1 and /dev/tty2) to communicate with the UPS.



P o s t  I n s t a l l a t i o n 

After installation, you should start the Power Monitor and the Console and run
tests of the hardware and the software. The procedures are given below.



S t a r t i n g  t h e  P o w e r  M o n i t o r 

If you chose the autoload on startup option when you installed your power
management software, restart your computer to start the software.

For a manual start of the software, run fs3.exe or ls3.exe for all systems except UNIX.
Procedures for starting LanSafe III for UNIX are as follows:

To start the For X Windows, type If you do not have X Windows, type
Daemon /usr/ls3/ls3& /usr/ls3/ls3&
Power Monitor Window /usr/ls3/ls3X& not applicable
Console /usr/ls3/ls3conX& /usr/ls3/ls3con
SNMP Agent n/a /usr/ls3/ls3agent&



For a manual start and shutdown of systems other than UNIX, the procedures are
below:

Node Type To Start To Shut Down
IBM OS/2 Run FS3.exe or LS3.exe Select File/Exit
NetWare 386 or 4.x File
Server

At file server, type Load LS3 At file server, type
Unload LS3

Windows 3.1x
Workstation

Open Power Monitor icon, or run FSLS3W Choose File/Exit

Windows 95
Workstation

Open Program folder on Start menu and choose
Power Monitor from the program folder— If you
accepted the Autoload on Startup default at
installation, restart your computer

Choose File/Exit

Windows NT
Workstation

    1. Start the system service    Open Services dialog box
in Program Manager Control Panel and start LanSafe
III or FailSafe III System Service

    1. Stop system
   service   

    2. Open the Window     Double-click Power Monitor
icon on Toolbar.

    2. Shut down
    program
Choose File/Exit

DOS workstation In LanSafe III directory, type LS3 LS3OFF



T e s t  t h e  S o f t w a r e 

1. Turn off the power to the power supply. If the hardware is connected to a power
strip, turn off the power at this source.

2. Verify that a power loss message displays on the message device you specified
during configuration.

3. Turn on the power supply source. When “Power is restored” displays, test is
complete.



M i s c e l l a n e o u s  Pr o c e d u r e s 

This section includes procedures for creating floppy disks from a compact disk,
reinstalling, and removing the software.



C r e a t i n g  F l o p p y  D i s k s  f r o m  a  C o m p a c t  D i s k 

If the LanSafe III for UNIX Installation program was not supplied on floppy disks
and you require them for a particular system, the procedure for creating floppy disks
from a compact disk is as follows:

1. Log on as root.

2. Mount the CD ROM.

3. Change to the directory were the compact disk is mounted.

4. Type cd images

5. Run ./CD2DISKS.SH <TARGET SYSTEM> or ./cd2disks.sh <target system>

... where the <target system> is the system in which the disks will be used. Target
system names the program recognizes are: aix3, aix4, dec, hpux, interactive,
linux, sco, solaris, sunos, svr4, and unixware2.



T o  R e i n s t a l l  L a n S a f e  I I I  o r  F a i l S a f e  I I I 

1. Be sure your files are not write-protected.

2. If you have a copy of LanSafe III or FailSafe III in the Startup folder, delete it
before reinstalling.



R e m o v i n g  L a n S a f e  I I I  f o r  U N I X 

Log in as root and type the following (assuming default installation directory)

rm -rf /usr/ls3

... where /usr/ls3 is the default directory.



S E C T I O N  3 

OPERATION
For your uninterruptible power system (UPS) hardware and power management
software to work together, they must communicate. When you start your power
management software, or when it starts automatically when your system is booted,
you start the Power Monitor (also known as the Power Monitor daemon in LanSafe
III for UNIX and the LanSafe III or FailSafe III system service in Windows NT).

Running in the background, the Power Monitor (or daemon or system service)
communicates with the UPS and provides information and services to the Console.
The Power Monitor also provides alert processing, orderly shutdown, and log
functions. The Console program is the primary user interface for system control,
diagnostics, managing alert response, and shutting down the system.

Communications require the use of the correct communications cable (the cable
furnished with the LanSafe III or FailSafe III software). The software must be
configured to reflect the computer communications port used for the cable. If your
UPS supports load segments, you can configure the load segments in the software,
too.



N o r m a l  O p e r a t i o n s  ( G r e e n  I c o n ) 

When LanSafe III or FailSafe III receives a command to start, the Power Monitor
attempts to establish communications with the UPS. If successful, the Power Log
records the date, time and a “Communications established with UPS” message. The
Power Monitor status window, if opened, displays the most recent events from the
Power Log.

If the Power Monitor cannot establish UPS communications, the result is a
“Communications failure with UPS” log entry. Until the communications setup is
corrected, the Power Monitor icon and Power Monitor status window display of the
message are yellow; the Console displays a yellow Input/Output Failure message.
See the Troubleshooting Guide, Appendix A.

If the operations situation is normal, the Power Monitor icon is green. Power Log
messages displayed on the Power Monitor status window are green.



B a t t e r y  O p e r a t i o n s  ( Y e l l o w  Ic o n ) 

If a power problem occurs, the UPS batteries provide system power until exhausted
or until expiration of the shutdown time you enter. The Power Monitor icon turns
yellow. The system shuts down either when battery power is gone, or in accordance
with your shutdown configuration.

Save your work and close your files immediately, then try to analyze and resolve
the problem. If the situation persists, contact your utility.



P o w e r  M o n i t o r  M e s s a g e s  f r o m  O t h e r  N e t w o r k  N o d e s 

Whenever a change in power status occurs, LanSafe III can generate Power Monitor
messages to network users with Windows, OS/2, and UNIX systems. To modify the
list of users to receive broadcast messages from your system, choose Customize
Alerts from the Setup menu.

Receipt of broadcast messages varies with your system, as follows:

• In OS/2 and UNIX, receipt of messages is automatic.

• In Windows 95, you must start WinPopup.

• In Windows NT, v. 4, you must either start WinPopup (NT 4.0 or higher
only) or run the Alerter and the Messenger services.

• In Windows 3.1x, you must start NetWare Popup (nwpopup.exe).



E m e r g e n c y  Op e r a t i o n s  ( R e d  Ic o n ) 

When a shutdown is about to occur, the Power Monitor icon and Power Monitor
Status messages related to the shutdown turn red. When power is restored, the icon
and messages return to green.



T h i n g s  t o  R e m e m b e r  A b o u t  R u n n i n g  t h e  S o f t w a r e 

• For full functioning of FailSafe III or LanSafe III software, a UPS must
support the node.

• Power monitoring occurs only after you start the Power Monitor within the
appropriate operating system or environment.

• If a system shutdown is necessary, the software saves only named files. To
avoid loss if a power failure occurs, name any new files as soon as you open
them.

• For applications with automatic saving capability, set the autosave time to a
value less than the power failure countdown time.

• To reconfigure the software, it is not necessary to reinstall or reload. New
configuration settings become active when you close the dialog box.

• Control is limited to the computer on which you run the Console and
LanSafe III remote nodes for which you enter the access code.

• Never try to run more than one copy of the software at once.



T h i n g s  t o  R e m e m b e r  A b o u t  U P S s  w i t h  D r y - C o n t a c t  I n t e r f a c e s 

• UPSs with dry-contact interfaces support only limited Console information.

• UPSs with dry-contact interfaces do not support hardware tests and
preventive maintenance.

• UPSs with dry-contact interfaces do not support the Battery Management
Log.



U n d e r s t a n d i n g  U P S  Gr o u p s 

There are differences, albeit small ones, in the installation and operation of Power
management software when your UPS supports one computer and when it supports
two or more computers. If the computers in your system each have their own UPSs,
you need not be concerned with this section.



U P S  G r o u p  T e r m i n o l o g y 

When one UPS supports more than one computer, the supported computers are
called a UPS group.

Only one computer in a UPS group can be attached to the UPS by means of a serial
communications cable. This computer is known as the UPS group controller. Any
computer in the UPS group that is not the UPS group controller is known as a UPS
group member.



U P S  G r o u p  C o m m u n i c a t i o n s  R e q u i r e m e n t 

LanSafe III communications require that the UPS group controller be running
whenever any group member is running. Otherwise, the LanSafe III UPS
monitoring module, which runs on each group member, cannot obtain UPS status
and alert information from the group controller. This means that UPS group
members are not notified of power failures and do not perform an orderly
shutdown.



T h i n g s  t o  R e m e m b e r  A b o u t  L a n S a f e  I I I  i n  a  U P S  G r o u p 

• LanSafe III communications require that the UPS group controller run
whenever any group member runs.

• The shutdown time for the UPS group controller must be longer than the
shutdown time for any group member.

• Any group member can run a LanSafe III Console to control and configure
LanSafe III for all units within the UPS group.



C o m m u n i c a t i o n s  Se t u p 

When you install the software, you designate the computer communications port
you use to join the communications cable to the UPS. If you change
communications ports on the computer, you must reconfigure the software.



T o  C h a n g e  C o m m u n i c a t i o n s  P o r t s 

1. Choose Communications Port from the Setup menu to open the
Communications Port Setup dialog box. All users but Novell file servers Go to
step 2. Novell file servers : Go to step 5.

2. All users but Novell file servers: Choose either Standard or Custom.

3. If you choose Standard, a list of communications ports becomes active. If you
choose Custom, an edit field becomes active.

4. If you selected Standard, highlight the port your computer uses for serial
communications with the UPS. If you selected Custom, enter the device name.
See your communications port manufacturer’s hardware manual for
information.

5. Novell file servers : Choose either COM1 IRQ4 Addr=03F8, COM2 IRQ3
Addr=02F8, or Custom.

6. If you selected COM1 IRQ4 Addr=03F8 or COM2 IRQ3 Addr=02F8, choose OK to
close the dialog box.



7. If you selected Custom, the IRQ field and Addr edit field become active and
require you to make entries. See your communications port manufacturer’s
hardware manual for information.



T o  R u n  t h e  C o n s o l e 

Do one of the following:

• Choose Run Console from the Power Monitor menu bar.

• In OS/2, double-click the Console icon in the program folder.

• In the directory where your power management files are stored, start
LS3CON.exe (LS3CONW.exe for Windows, Ls3con95.exe for Windows 95).



M o n i t o r i n g  a  Po w e r  En v i r o n m e n t 

Using the PowerScope or Data view of your Console, you can monitor the power
environment of your local node. In LanSafe III, you can monitor any node in your
network. If your utility power is 3-phase, you can view by input and output phase.
Monitoring includes the ability to review logs.

Data view and PowerScope share the same sections for node information and
communications status.

NOTE
PowerScope view and Data view are limited on UPSs with dry contact interfaces

Node/System Information section. Node information (System Information in
FailSafe III)  includes the software type and version, and the UPS model name,
numbers and revision. In LanSafe III it includes the node type and address.

Communications status section. Communications status is a text message
describing the state of current communications.

The PowerScope diagram reads from left to right. It includes values for input
voltage, output voltage, available run time, the current battery or ABM status, and
the current load %.



Volts In. The Volts In section on the left side of the screen shows the voltage of
utility power and a colored bar. The color describes the power situation, either as
acceptable (green), near range limits (yellow), or out-of-range (red). For the UPS to
operate on utility power, the voltage must be in the green range.

Volts Out. The Volts Out section on the right side of the screen shows the output
voltage of on the UPS with a colored bar. Colors have the same meaning as in the
Volts In section.

Use the Volts Out information and the % Load value to evaluate the utilization of
your UPS. If the % Load value is in the yellow or red range, your power
requirements demand a UPS with a higher load capacity. If the load value is in the
red range, the UPS is overloaded, and a computer shutdown will occur in one
minute or less. If the load value is in the green range, you are operating safely
within the load range of the UPS.



T o  S e l e c t  I n p u t  a n d  O u t p u t  P h a s e s  f o r  V i e w i n g 

1. Choose Input Phase 1, Input Phase 2, or Input Phase 3 from the View menu.

2. Choose Output Phase 1, Output Phase 2, or Output Phase 3 from the View menu.
Input and output phase numbers need not be the same.

3. Choose either Data view or PowerScope from the View menu.



T o  C h a n g e  C o n s o l e  V i e w s 

From the View menu, choose either Data or PowerScope.



T o  S e l e c t  A n o t h e r  N o d e  t o  M o n i t o r  ( L a n S a f e  I I I ) 

1. From the File menu, choose Select Node.

2. Select the node.

3. Choose Select Node.



V i e w i n g  t h e  Lo g s 

Your power management software provides a Power Log, a Battery Management
Log, and a Periodic Log for each node. On the Power Log and Battery Management
Log, significant events are arranged by date and time. On the Periodic Log, the flow
of power is displayed as a graph. You can export the Power Log and Battery
Management Logs as text to an ASCII file which you can print. Data from the
periodic log is saved to an ASCII file which a spreadsheet program can interpret. In
LanSafe III, to clear logs other than your own, you must have the UPS access code.

NOTE
FailSafe III and LanSafe III for Windows 3.1x do not support the Periodic Log.



T o  A c c e s s  a  L o g 

From the Logs menu, choose View/Clear Power Event Log, View/Clear Battery
Management Log, or View/Clear Periodic Log.



T o  E n a b l e  t h e  P e r i o d i c  L o g 

1. From the Setup menu, choose Periodic Log Setup.

2. From the Periodic Log Setup dialog box, choose Enabled.



T o  E s t a b l i s h  P e r i o d i c  L o g  S e t t i n g s 

1. In the Periodic Log Setup dialog box, set a Sample Rate (in minutes), using the
Sample Rate (Minutes) spin field.

2. Set the number of days the file should be kept, using the Keep logs for (Days) spin
field.

3. Note in the “Logs will occupy” message that the required disk space varies with
the sample rate and with the number of days the log is to be kept.



S y s t e m  Co n t r o l  F e a t u r e s 

Control features include setup, shutdown, and deleting the logs. Control is limited
to your local node. To control another network node running LanSafe III, you must
enter the proper access code at your computer.



T o  S e l e c t  a  L a n S a f e  I I I  N o d e  t o  C o n t r o l 

1. Choose Select Node from the File menu to open the Select Node dialog box.

2. In the node lists, highlight the node you wish to control. If you highlight a node
in a UPS group, you must highlight the entire group. Use the
Domains/Networks list to change the lists of File Servers or Domain Controllers,
Other Servers or Hosts, and Workstations or Requesters. Choose Rebuild List to
refresh the list.

3. Click the Enter Access Code button and enter the LanSafe III access code for the
node you wish to control.

4. Choose Select Node.

5. The Console Node Information section shows the name and address of the node
you selected to control.



T o  C o n t r o l  a  N o d e  w i t h  A n o t h e r  L a n S a f e  I I I  A c c e s s  C o d e 

1. Choose Enter Access Code from the File menu to open the Enter Access Code
dialog box.

2. Enter the access code.

3. Select the node at the Select Node dialog box.



T o  C h a n g e  t h e  L a n S a f e  I I I  A c c e s s  C o d e  f o r  a  N o d e 

1. Choose Access Code from the Setup menu to open the Configure UPS Access
Code dialog box.

2. Enter the new access code.

3. Verify the new access code.

This code change applies to the node whose name and address appear in the Node
Information section of your Console display.



T o  C h a n g e  t h e  L a n S a f e  I I I  A c c e s s  C o d e  f o r  a  N e t w o r k 

1. Choose Access Code for Network from the Setup menu to open the Configure
UPS Access Code for Network dialog box.

2. Use the Networks list to select the network or network segment to which the
new access code is to apply.

3. Enter the new access code.

4. Verify the new access code.



T o  C o n f i g u r e  t h e  N e t w o r k  U P S  A c c e s s  C o d e  f o r  a  U P S  G r o u p 

In LanSafe III, when you open the Configure Network UPS Access Code dialog box,
the list box shows UPS group members. The new access code applies to the group
controller and its members.



D i a g n o s t i c s  Ta s k s 

Diagnostics consist of running a hardware test and preventive maintenance either
for the local node or the network. The procedures are the same. In addition, you can
program your power management software to put a maintenance reminder on your
Power Monitor window.

NOTE
UPSs with dry-contact interfaces do not support hardware tests or preventive maintenance.



T o  S e t  U p  a  M a i n t e n a n c e  R e m i n d e r 

1. From the Setup menu, choose Maintenance Schedule to open the Maintenance
Schedule Setup dialog box.

2. Choose Enabled to set a schedule or Disabled if you do not want a reminder to
appear in the Power Log at set intervals.

3. If you choose Enabled, the Days Between Runs field become active. Use the arrow
keys to specify the interval (in days) between maintenance reminders. This may
be any number between 30 and 999 (the default is 90).

Reminders appear in the Power Monitor window.



T o  T e s t  H a r d w a r e  f o r  t h e  S e l e c t e d  N o d e 

1. From the Maintenance menu, choose Test Hardware to open the Test Hardware
dialog box.

2. Choose Start.

The test places the UPS on battery for several seconds. During this time, the UPS
verifies the battery and internal circuit operation. It displays the current testing
status.

To close the dialog box without starting a test, choose Exit. To close the Test
Hardware dialog box during a test, start the test and choose Exit. The test continues.



T o  T e s t  H a r d w a r e  f o r  N e t w o r k  ( L a n S a f e  I I I ) 

1. Choose Test Hardware for Network from the Maintenance menu to open the
Test Hardware for Network dialog box.

2. Use the Domains/Networks list and the Domain Controllers/File Servers, Other
Servers/Hosts, and Workstations/Requesters check boxes to create a List of
Power Monitor Nodes to Test.

3. Choose Start.

A message lets you know how much time has passed and when testing finishes.

To close the dialog box without testing, choose Exit. To close the Test Hardware
dialog box during a test, start the test and choose Exit. The test continues.



T o  R u n  P r e v e n t i v e  M a i n t e n a n c e 

Follow the procedure for a hardware test, choosing either Preventive Maintenance
or Preventive Maintenance for Network from the Maintenance menu.



A l e r t  R e s p o n s e 

The role of the UPS is to put your system on UPS battery power in the event of a
power emergency and to complete an orderly shutdown without loss of data.
Depending on your needs, you can configure the length of time the system remains
on battery before shutting down, with either maximum or minimum battery use.
Using the Customize Alerts feature, you can program the system to send alert
messages to key personnel, even at remote addresses.



T o  R e c o n f i g u r e  S h u t d o w n  T i m i n g 

1. Choose Shutdown Timing from the Setup menu. If your selected node is a
standalone, the Shutdown Timing Setup dialog box opens. If your selected node
is a UPS group, the UPS Group Shutdown Timing Setup dialog box opens.

2. Enter values for wink time, power failure countdown time, and time needed to
down system.

Wink time eliminates nuisance messages from brief power interruptions. Choose
any integer between 1 and 999 (the default value is 5 seconds).

Power failure countdown time gives you time to finish your work and save your
files. Each minute, you are informed of the time remaining until shutdown. Choose
any integer from 1 to 999 (the default value is 5 minutes).

Time needed to down system allows the Power Monitor to log off users, terminate
any applications that are still running, and close all files in the computer’s file
system. The time may be any integer from 1 to 999 .



If you configure a UPS group shutdown time you cannot set the shutdown time for
the UPS group controller at a value less than the shutdown time for any group
member. To reduce the shutdown time for the UPS group controller to a value less
than the current shutdown time for a group member, you must first reduce the
shutdown time for the member.



T h i n g s  t o  R e m e m b e r  A b o u t  S h u t d o w n  T i m i n g 

• The length of battery protection increases as the load on the UPS decreases.

• After a power outage, another outage could occur before the UPS batteries
fully charge. For complete system fault tolerance, set the countdown time at
a value small enough to allow battery reserve for at least two shutdowns.

• It is extremely important that the UPS not shut off until all applications are
terminated and all files in the file system are closed. Set the time needed to
down the system at a value large enough to assure that the Power Monitor
software has time to shut down a worst-case computer environment.



C u s t o m i z i n g  A l e r t s 

The Customize Alerts feature enables you to change the text for alert messages, and
to cause a particular alert to execute a command, send an e-mail message, send a
string to a modem, or to send a broadcast message to selected users. If supported, you
can also activate NetFinity alerts from the Customize Alerts dialog box.

In all cases, the basic procedure is as follows:

1. Choose Customize Alerts from the Setup menu to open the Customize Alerts
dialog box.

2. Select one or more messages from the scroll list at the left side of the box, or
choose Select All. If you select only one message, or if all selected messages have
the same text, a customizable message for a selected alert appears in the Message
Text list.

3. Follow the procedure for the customization you wish to make (see below).



T o  C h a n g e  t h e  T e x t  f o r  a  M e s s a g e 

Enter a new message in the Message Text list, or translate the message to another
language.



T o  E x e c u t e  a  C o m m a n d  w h e n  a n  A l e r t  O c c u r s 

1. Put a check in the Execute Command box.

2. Click the Execute Command edit field.

3. Enter a fully qualified path name for the command and any parameters, using
the variables that appear in the Substitution Variables box.

If you selected multiple alerts and the alerts do not all execute the same command,
the check box and field are gray. To set multiple alerts to execute the same
command, select the alerts and complete this field. To change the action the system
takes in an alert situation, choose a message and type a new command in the
Execute Command edit field. If the command is a DOS executable or batch file, you
must include the extension, for example, EXECUTE.EXE for a DOS executable or
FILE.BAT for a batch file. For help in writing a DOS command or a batch file, see
your DOS documentation or on-line help. To test operation of this command in real
time, choose the Test button.



T o  S e n d  E - M a i l 

NOTE
To receive e-mail, a Windows 3.1x node or a Windows 95 node in a Novell network must run a
messaging application program interface (MAPI)-capable messaging software program such as MS
Exchange (indigenous to Windows 95) or MS Mail. An OS/2 node must install vendor independent
messaging (VIM) software such as Lotus CC:Mail. The CC:Mail Post Office must be level 6 or above, and
you must add a mailbox named lansafe with the password lansafe.

1. Select a message in the message list.

2. Check the E-mail box.

3. In the text edit field, type the e-mail addresses of the persons to whom you want
this message sent should it be necessary to send it. Separate multiple addresses by
commas.

If multiple alerts are selected, the check box is gray unless all the alerts send e-mail
to the same destinations.

To set multiple alerts to send e-mail to the same users, select the alerts and enter
their names in this field.



CAUTION
Choose Defaults only to return all messages and strings (including saved messages and strings) to their
factory settings.

The e-mail recipient receives the message via the recipient’s mail system. The
sender may send e-mail by a different mail system. Recipients should be sure their
systems are set up to receive e-mail from all potential senders. See documentation
for the specific systems for details.

To test operation of this command in real time, choose the Test button for E-Mail.



T o  S e n d  a  S t r i n g  t o  a  M o d e m 

1. Put a check in the Send String to Modem check box.

2. Specify the modem port by choosing Comm Port to open the Communications
Port dialog box.

3. Click the text field.

4. Using the variables that appear in the Substitution Variables box, enter a string to
be sent. See Creating a Modem String.

If you select multiple alerts, the check box and text field are blank unless all the
alerts send the same string to the modem.

To set multiple alerts to send the same string to the modem, select the alerts and
enter the string.

To test operation of this command in real time, choose the Test button.



C r e a t i n g  a  m o d e m  s t r i n g 

Exact instructions for creating a modem string vary from carrier to carrier. However,
the following example, which assumes SkyPage and the Windows Terminal
program, should provide the essential details for you to create a modem string in a
system other than SkyPage and Windows, if necessary. After creating your modem
string, be sure to test it.

NOTE
If your service does not handle alphanumeric messages, check with your service.

ATZ (Return & Wait)
OK
ATDT918007599673 (Return & Wait)
CARRIER 2400
PROTOCOL: LAP-M
COMPRESSION: NONE
CONNECT 2400/ARQ (Return & Wait)
SKYTEL REMOTE TERMINAL
PAGER ID: 3024258 (Return)
FUNCTION: (Return)
ENTER ALPHA MESSAGE: TEXT HERE (Return)
SEND ?: (Return)
FUNCTION: 99 (Return)
In this case the dialing string would be as follows:

ATZ$RET$WAIT$ATDT18007599673$RET$WAIT$RET$WAIT12345678$RET$TEXT HERE$RET$RET99$RET



The following table shows definitions of the string and variables:

ATZ Soft reset modem and restore active profile 0*.
$ RET Carriage Return (Enter).
$WAIT Wait for any string to return from other modem.
ATDT Dial in touch tone mode (Always followed by the phone number with any necessary prefixes or

suffixes). i.e. 918005551212. 9, to get an outside line, 1 for long distance and 8005551212 is
the area code and phone number of the modem/service you wish to call.

TEXT HERE Pertinent text should be inputted exactly as you would like it to display on the pager. You can
use one of the wild cards listed below to substitute from data collected from the connected CPU.

$MSGNU
M

The actual number of the alarm from list or manual.

$MACHINE The name given to the CPU (Not by LanSafe III or FailSafe III software).
$MESSAG
E

Repeat the message string set up in the “Message Text” window. Can change language and
include variables also.

$MINUTES Minutes remaining until shutdown.

*Modem Profile should be pre-configured for your service (bits, parity, stop bits, and baud rate (that is,
8, none, 1, 2400).



T o  S e t  a  D e l a y  T i m e  f o r  a n  A l e r t  M e s s a g e 

You can set a delay on particular messages in addition to the wink time set under
Shutdown Timing. If the situation is resolved before the combined wink time and
delay time expire, you are not interrupted.

1. Select a message.  If a delay time can be set for the message, the Delay Time
(seconds) edit field becomes active.

2. Select a delay time.



T o  S e n d  B r o a d c a s t  M e s s a g e s  t o  L o g g e d - O n  U s e r s  ( L a n S a f e  I I I ) 

NOTE
This feature is not available in Windows 95.

1. Put a check in the Broadcast Message to Users check box.

2. Choose the users to receive broadcast messages, using the All radio button to
send a message to all users or the Some radio button to send a broadcast message
to those you specify in the list box. If you select multiple alerts, the check box is
gray unless the alerts send broadcast messages to the same users.

3. To set multiple alerts to send broadcast messages to the same users, select those
alerts and complete the information in this area. To test operation of this
command in real time, choose the Test button. Users who are not logged in at
the time of the alert do not receive a message.



T o  S e n d  N e t F i n i t y  A l e r t s 

Place a check mark in the Send a NetFinity Alert check box.



R o u t i n e  Sh u t d o w n s 

Use FailSafe III or LanSafe III to shut down all or part of your system at any time. If
your UPS supports load shedding, you can schedule shutdowns on a regular basis.
Use to the Shutdown menu to shut down the selected Power Monitor node, and
unload the Power Monitor program at the selected node. Use the Weekly Schedule
option under the Shutdown menu to schedule shutdowns and restarts at a set time.



T o  U n l o a d  t h e  P o w e r  M o n i t o r  ( L a n S a f e  I I I ) 

Choose Unload Power Monitor from the Shutdown menu.

NOTE
Exercise extreme caution in using the Shutdown menu. If a server is shut down from the Console, all users
on the server are forcibly logged out, and work in progress may be lost.

When a UPS group member chooses Unload Power Monitor from the Shutdown
menu, the UPS Group Unload dialog box opens. You can unload UPS group
members, but if you unload the UPS group controller you automatically unload the
entire group.



T o  S h u t  D o w n  a n d  R e b o o t  t h e  S y s t e m 

1. Choose Shutdown/Reboot System from the Shutdown menu to open the
Shutdown/Reboot dialog box.

2. For an automatic reboot after shutdown, choose Reboot. If your UPS supports it,
choose Timed for a shutdown of a specific length, or choose Permanent for a
system shutdown until the UPS is restarted.

3. Choose Shutdown.

Choosing Timed activates the Time To Come Up spin field where you set a date and
time for the system to reboot.



T o  S h u t  D o w n  a  L o a d  S e g m e n t  o n  a  S c h e d u l e d  B a s i s 

Only UPSs supporting load shedding support this feature.

1. Choose Weekly Schedule from the Shutdown menu.
The Weekly Schedule dialog box opens.

2. Highlight a load segment.

3. Use the Weekday scroll field to designate the day of the week to which the
schedule is to apply.

4. Use the Goes Off At scroll field to designate the time power to the load segment
is to turn off.

5. Use the Goes On At scroll field to designate the time power to the load segment
is to turn on.



L o a d  Sh e d d i n g 

If your UPS supports load shedding, you can divide your load into segments with
various shutdown or restart delays. At the start of an emergency, load shedding is
used to shut down non-essential equipment so there is more battery power for the
essential equipment. It is used at startup to bring essential servers or other
equipment on line before non-essential equipment is started.



T o  C o n f i g u r e  L o a d  S e g m e n t s 

1. Attach your computer and peripherals to the numbered load segment receptacle
groups on the rear of your UPS.

2. Choose Load Segment Configuration from the Setup Menu. The Load Segment
Configuration dialog box opens.

3. In the Load Segment/Computer List, drag the icon for your computer to the Load
Segment to which it is physically attached on the back of your UPS. Your non-
essential peripherals should be physically attached to the other Load Segment on
back of the UPS.



T o  S h o r t e n  a  S h u t d o w n  D e l a y 

NOTE
Before setting a shutdown delay, you must configure your load segments. See the Load Segment
Configuration procedure.

1. In the Load Segment Configuration dialog box, choose the Load Segment for the
devices other than your computer.

2. Set a Power Failure Run Time, using the Power Failure Run Time scroll list.



T o  D e l a y  R e s t a r t  o f  a  L o a d  S e g m e n t 

1. In the Load Segment Configuration dialog box, choose the Load Segment for the
devices other than your computer.

2. Set a Restart Delay, using the Restart Delay [seconds] scroll list.

NOTE
You can also set this delay by using the Restart Delay dialog box. Choose Restart Delay from the Setup
menu.



T o  S e t  a  R e s t a r t  D e l a y 

This feature is supported only by certain UPSs. See your UPS manual for details.

Specify a restart delay for any load segment with equipment you do not need
immediately upon reboot. Servers or your computer can be left with a zero restart
delay (the default), while workstations or peripherals can be programmed with a
later restart delay.



T o  D e l a y  R e s t a r t  o f  N o n - E s s e n t i a l  P e r i p h e r a l s 

1. Choose Restart Delay from the Setup menu. The Restart Delay dialog box opens.

2. Select the Load Segment to which your computer is attached.
The computer name appears in the Attached Computers box.

3. Set a restart delay, using the Restart Delay [seconds] scroll list.

You can also set this delay by using the Load Segment Configuration dialog box.
Choose Load Segment Configuration from the Setup menu.



A c c e s s i n g  th e  H e l p  Sy s t e m 

To access online help from any dialog box, press F1. To access the complete online
help program, choose General Usage from the Help menu.



T o  C h e c k  t h e  S o f t w a r e  V e r s i o n 

Choose About from the Help menu to open the About dialog box.



A l t e r n a t e  Co n s o l e  St a r t u p  Me t h o d s 

For alternate methods for running the LanSafe III Console, see below.



T o  M o n i t o r  L a n S a f e  I I I  o n  A n o t h e r  N o d e 

Do one of the following:

• Start the Console, and select the node using the Select Node dialog box.

• In the directory with your LanSafe III files, start LS3CON NodeName
(LS3CONW NodeName for Windows 3.1x).



T o  C o n t r o l  L a n S a f e  I I I  o n  A n o t h e r  N o d e 

Do one of the following:

• Start the Console, choose Enter Access Code from the File menu, enter the
other LanSafe III access code, and select the node using the Select Node
dialog box.

• In the directory with your LanSafe III files, start LS3CON /A=AccessCode
NodeName (LS3CONW /A=AccessCode NodeName for Windows 3.1x).



T o  C o n t r o l  a  N o d e  i n  a  G r o u p  W h o s e  A c c e s s  C o d e s  D i f f e r  f r o m  Y o u r s 

Do one of the following:

• Start the Console, enter the access code, and select the desired node using
the Select Node dialog box.

• In the directory with your LanSafe III files, start LS3CON /A=AccessCode
(LS3CONW /A=AccessCode for Windows 3.1x).



T o  L i m i t  Y o u r  B u i l d  t o  S p e e d  N e t w o r k  P o l l i n g 

1. Create a text file in the directory where your LanSafe III files are stored listing one
network segment per line.
To add a comment to a line, type # and your text. The system will not read it.

2. In the directory where your LanSafe III files are stored, start
LS3CON/Networks=MYNETS.TXT (LS3CONW/Networks=MYNETS.TXT for
Windows 3.1x).

Rather than poll the entire network, LanSafe III polls only the network segments on
your list.

If you do not enter a command line parameter, the Console attempts to read a file
named NETWORKS.TXT in the LanSafe III directory. If this file does not exist, the
entire network is polled.



S E C T I O N  4 

UNIX TEXT-BASED
ENVIRONMENT OPERATION

You can run LanSafe III for UNIX without X Windows using a text-based
environment. Operation is from a Main Menu. Options appear on the terminal
screen as text prompts.

You can monitor and control all functions for your own node. You can monitor all
nodes in your network. To control them, you must have the access code.

Before you begin, be sure the daemon (ls3) is running.



T o  St a r t  th e  La n S a f e  II I  Co n s o l e  f o r  Yo u r  O w n  N o d e 

Assuming the default installation path, type /usr/ls3/ls3con



T o  S t a r t  L a n S a f e  I I I  a n d  S e l e c t  a  N o d e  O t h e r  t h a n  Y o u r  O w n  t o  V i e w  o r 
C o n t r o l 

Type /usr/ls3/ls3con [-a accesscode] [hostname]

...where [hostname] and [-a accesscode] apply to the node you wish to
view or control.

If you do not know the access code, press <Enter> to bring up a version of the
Console in which only options 1 and 5 are active, allowing you to monitor but not
control the node.

Options 1 through 4 of the Console Main Menu are disabled if the wrong access code
is entered. Individual features are disabled if the UPS does not support them.



C o n f i g u r i n g  La n S a f e  II I 

Choose 1 from the Main Menu to open the Configure LanSafe menu.



T o  C l o s e  t h e  S c r e e n  a n d  R e t u r n  t o  t h e  M a i n  M e n u 

1. Type 0.

2. Type y to save or n to discard any configuration changes.



T o  E n t e r  a  N e w  C o m m u n i c a t i o n s  P o r t 

1. Type 1.

2. Type the device name.

For a list of device names, see section 2, Installation.



T o  C o n f i g u r e  S h u t d o w n  T i m i n g 

1. Type 2.

2. Enter values for wink time, power failure countdown time, and time needed to
down system.

See section 3, Operation, for an explanation of these values.



T o  S c h e d u l e  M a i n t e n a n c e 

Type 3 and enter the number of days between maintenance reminders. The
reminders appear in the Power Monitor window and the Power Log each day until
you run preventive maintenance.



T o  C h a n g e  t h e  A c c e s s  C o d e 

[This applies to the node whose hostname and address appear on the Main Menu.]

1. Type 4.

2. Enter the new access code.

3. Reenter it.

4. When the “Are You Sure?” prompt appears, type y to confirm or n to abort the
code change.



T o  S a v e  a n y  S e t t i n g  C h a n g e s  Y o u  H a v e  M a d e 

Type 5.



T o  C a n c e l  a n y  C h a n g e s  a n d  R e s t o r e  t h e  D e f a u l t s 

Type 6.

Use this option to return the system to the defaults even after you have made
changes and saved and entered them.



R u n n i n g  a  H a r d w a r e  T e s t  o r  P r e v e n t i v e  M a i n t e n a n c e 

1. From the Main menu, choose 1 to run a hardware test or 3 to run preventive
maintenance.

2. Refer to the Console Data View Operational Status display.

3. If a problem is found, a message appears.



S h u t t i n g  D o w n  o r  R e b o o t i n g  t h e  W o r k s t a t i o n 

1. From the Main menu, choose 4 to open a list of shutdown/reboot options.

2. Type 1 for a long shutdown, 2 for a short shutdown, 3 for a permanent
shutdown, 4 to shut down the LanSafe III daemon and terminate LanSafe III
power protection, or 0 to close the screen and return to the Main menu.

If you are considering a long or a short shutdown, see your UPS documentation to
determine if the unit supports shut downs of varying lengths. If you choose a
permanent shutdown, restart your system in accordance with your UPS
documentation.



M o n i t o r i n g  a  P o w e r  E n v i r o n m e n t 

From the Main menu, choose 5 to open a list of UPS values for utility and battery
power.

Contents of this list vary according to UPS model.

Backup Time is the number of minutes the UPS is capable of supporting your
system as presently configured.



T o  U p d a t e  t h e  L i s t ,  o r  t o  C l o s e  I t 

1. Press any key and <Enter>.

2. Type 1 to update the listed values or 0 to close the list.



E x p o r t i n g  L o g  F i l e s 

1. From the Main menu, choose 6 to open a list of log export options.

2. Type 1 to export the Power Log or 2 to export the Battery log.



A P P E N D I X  A 

TROUBLESHOOTING
If your power management software fails to perform as it should, here is a list of
things to check:

1. Be sure that communication between the UPS and your computer is correctly set
up and configured.

• Be sure you are using the correct communications cable. If a cable was
included with the UPS, use that cable only. If a cable was not included with
the UPS, use the cable that came with your software.

• Be sure the computer communications port used is a dedicated port.

• Be sure the computer communications port is the one chosen in the
Communications Setup dialog box.

• Test your communications port: Remove the communication cable and
replace it with your mouse. If you cannot move your cursor, the port is
inoperative.



2. For Windows NT and Novell environments, be sure you are running LanSafe
III in a computer network, not a standalone computer.

3. If you are running LanSafe III in a network, be sure you have logged on to your
network in accordance with the correct procedures.

4. Review the system requirements for file servers and workstations in Section 2,
Installation.

5. Review the lists in Things to Remember About Running the Software, and
Things To Remember When Running LanSafe III in a UPS Group in Section 3,
Operations.

6. See Table A-1.

To reinstall, see Section 2, Installation.



Table A-1.  Troubleshooting (Novell, Microsoft, OS/2 Platforms)
Problem Possible Cause Solution
Message: Must log on to server with
SUPERVISOR rights

You are not logged into a file server Log on, using account with SUPERVISOR
rights

Account you logged onto lacks SUPERVISOR rights Log on, using account with SUPERVISOR
rights

I do not see file server You are not logged on to or attached to file server Log on or attach to server using account with
SUPERVISOR rights

I want to install on list displayed by
LanSafe III

The account you are logged on or attached to does
not have SUPERVISOR rights

Log in or attached to server you want to
install, using account with SUPERVISOR
rights

Message: Configuration file error Installation unsuccessful Reinstall
User installed for LanSafe III lacks SUPERVISOR rights Assign SUPERVISOR rights to user

Installation successful, but Console cannot
see node

Power Monitor not loaded after installation Start Power Monitor

Message: Unable to Contact Power Monitor Software not running Start Power Monitor
Message: Cannot contact UPS Group
Controller

Group Controller not running LanSafe III Start LanSafe III on Group Controller node

Message: Comm port unavailable Another hardware device is configured with same
IRQ or I/O address as LanSafe III or FailSafe III

Reconfigure LanSafe III or FailSafe III and
communication port hardware with different
addresses

Communications error message; or power
failure or low battery messages despite no
apparent failure; or, no messages when
power failure is simulated

LanSafe III or FailSafe III and cables configured on
different communication ports

Reconfigure communications port

Interface cable not connected, secure, or properly
installed

See UPS Hardware installation manual



If yours is a UNIX system, see the list below.

Problem: Message when I try to tar off the tape or diskette: Device not
found or unable to open device

Solution: Check system documentation for correct device identification.

Problem: Message: Cannot find install.ls3
Solution: 1. Part of installation failed.

2. Check disk space and root permissions.

Problem: Message during install: Files cannot be found
Solution: Tar tape or diskette again and rerun install.sh

Problem: Message when installation is completed: Power Failure
Solution: Cable connected to wrong serial port.

Cable not connected to UPS.
Wrong cable type entered.



Problem: Some nodes do not appear in Select Power Monitor Node dialog
box.

Solution: Power Monitors must be running on these nodes. Nodes must be
reachable from the local node. To verify, use ping. Mapping for ls3
port must be the same on all machines. If NIS, NIS+, Yellow Pages,
or some other network mapping service is running, then the
services map must have entries for ls3.
For example:
ls3 3069/tcp
ls3 3069/udp

Otherwise the file /etc/services must contain the port mapping
for ls3.
For example:
ls3 3069/tcp
ls3 3069/udp

The installation script modifies /etc/services. By default, the
installation script tries to use port 3069, but if this port is being used
the installation script chooses another. To make the change to
/etc/services visible in an NIS environment, log on to the node
acting as the NIS master, add the LS3 port mapping to the local
/etc/services, and execute:
cd/var/yp
make



Problem: The Power Monitor does not start when system is booted but
running ls3. works.

Solution: LanSafe III may be installed on an NFS file system. During system
boot the directory containing LanSafe III is not yet mounted. Move
S891s3.init from /etc/rc2.d to /etc/rc3.d.

Problem: System alternates between “On backup power” and “Power
Restored”.

Solution: LanSafe shares serial port with another process, most likely a getty
process. Connect UPS to another port and reconfigure LanSafe, or
terminate the getty.

Problem: Intermittent serial I/O error.
Solution: Be sure that only one LanSafe III daemon process is running and

that no other process is using the same serial device.

Problem: Power removed from UPS but no message.
Solution: Be sure the LanSafe III daemon process is running (ls3).

Be sure the cable is connected to the UPS.
Be sure the cable is connected to the correct serial port.



Problem: UPS reports serial I/O error.
Solution: Be sure the interface cable is properly installed and secure.

Verify that the Console is set to use the port to which the cable is
connected.

Problem: “Cannot write to port” message.
Solution: Be sure root has read/write privileges on the port.

Be sure that only one LanSafe III daemon process is running and
that no other process is using the same serial device.

Problem: “Cannot connect to daemon” message.
Solution: Be sure the ls3 daemon is running. If not, start the daemon from

the command line via /usr/ls3/ls3 (assuming it is installed in the
default directory).
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GLOSSARY
This glossary defines terms and other technical terms as used in power
management. For definitions of more general terms, see a standard computer
reference.

ABM™. The abbreviation for Advanced Battery Management, and a trademark of
Exide Electronics. ABM is a proprietary, microprocessor-based, state-of-the-art system
for monitoring and managing UPS batteries, with such features as quick recharging,
doubled battery service life, and up to 60 days of early warning before your batteries
need replacement. ABM prevents overcharging and accelerated battery aging by not
constantly charging the battery.

Access Code. A means of facilitating the use of LanSafe III software, and of preventing
unauthorized shutdowns and disabling.

Battery Management Log. A record of ABM or Battery status whenever the ABM or
battery changes state. Records include log started, charging, discharging, floating
(meaning battery is receiving only a nominal charge), log stopped, and log cleared.
ABM systems include a “resting” message when the battery is receiving no charge.
This ABM feature reduces battery wear.



Blackout. A complete loss of utility power to the UPS.

Boost and Buck. A proprietary line regulation process used when an overvoltage or
undervoltage situation occurs in the UPS. Undervoltage is boosted to make it
greater and overvoltage is bucked to reduce it, thus reducing reliance on the battery.

Brownout. A condition where the utility power voltage drops below the lower limit of
the UPS, causing a switch to battery power via the inverter.

Bypass Circuitry. A feature of some UPSs which causes your system load to be powered
directly from the UPS input. See your hardware manual for details.

Charger. See Rectifier/Charger.

Console. Your primary interface with the UPS through the software. It allows you to
view and control the power environment of every node where the Power Monitor
is running.

Data view. A Console display of colored bar graphs and text to give you a concise but
comprehensive overview of the UPS hardware and the utility power situation.
Values are updated at various intervals of less than 30 seconds to reflect a current
picture of the environment. See PowerScope.



Domain. In Windows NT, a group of computers with its own name, database, and
security policy. The computers are classified as the domain controller, other servers
(when used), and workstations.

Domain Controller. In Windows NT, the server that maintains the domain’s security
policy and master database, and authenticates domain logons. Domain controllers
run Windows NT Advanced Server. A domain may include other servers which
receive copies of the domain’s security policy and databases.

Emergency Shutdown. An automatic feature in the event of a UPS low battery or
overload condition. The Power Monitor begins to shut down applications and files.
Shutdown time is UPS-specified and depends on your UPS. Refer to your UPS
manual. See also Orderly Shutdown.

Filters. The UPS components that prevent corruption of system data by helping to
ensure that transients and high frequency noise are reduced or eliminated.

Hardware Test. Places the UPS on battery power for several seconds to verify proper
operation of the hardware.

Inverter. The UPS component that converts DC from your UPS battery to AC for
powering your system.



Load Shedding. A UPS feature enabling users to remove connected devices from the
load. Load shedding extends the power of your UPS battery.

Other Server. In Windows NT and Lan Server, the computer that receives a copy of
the domain’s security policy and domain databases, and authenticates network
logons. Other servers are distinguished from the domain controller which
maintains the domain’s security policy and master database. Other servers run
Windows NT Advanced Server.

Orderly Shutdown. The power management software process, activated after a utility
power failure, which protects users and file systems from lost or corrupted data.
Power management software saves work in progress and shuts down your system in
accordance with the shutdown timing you set.

% Load. A percentage of the UPS’s calculated full load capacity.

Power Failure Countdown Time. The time in minutes after the end of wink time that the
software waits before starting a shutdown sequence. Use this time to save your work
and log out before your computer goes down.

Power Log (Power Event Log). A record of significant power events, including power
outages, low battery and overload indications, hardware self-test results, software
loads and unloads, serial communication connections and failures, and preventive
maintenance reminders.



Power Monitor. The software component that communicates with your UPS to
monitor the status of the input utility power, output load and condition of the UPS
hardware. The Power Monitor also watches the power environment and provides
alert processing, orderly shutdown, and logging functions.

In Windows NT, the Power Monitor consists of a Windows NT system service and
window. The system service communicates with your UPS and provides alert
processing, orderly shutdown of your file system, and logging functions. In the
event of a utility power failure or other significant power event, the icon for the
window appears on top of your currently active window and beeps until you open
it. If a shutdown is necessary, the window shuts down your applications.

PowerScope. A system diagram with a full color display of your power. It is a View
menu option. Values are updated at various intervals of less than 30 seconds to
reflect a current picture of the power environment.

Preventive Maintenance. A procedure by which the UPS is placed on battery power for
several seconds to verify proper operation of your hardware. If your UPS does not
support preventive maintenance, a hardware test is run.

Rectifier/Charger. In some UPSs, a rectifier converts AC to DC. In others, a charger
which includes a rectifier converts AC to DC.

Requester. A computer running OS/2. See Workstation.



Restart Delay. A control of the Load Segment Configuration and Restart Delay dialog
boxes used to bring up a server before workstations, or to bring up peripherals after a
workstation or workstations have been brought up.

Run time. Maximum battery time available to support your system until inverter
shutdown, based on current load and UPS conditions.

Surge Condition. A situation in which utility power voltage exceeds the upper limit of
the UPS, causing a switch to battery power.

Time Needed to Down System. The time in seconds from when the software begins to shut
down your system until the power from the UPS shuts off.

UPS. Uninterruptible power system.

UPS Group–Group Controller–Group Members. When one UPS supports more than one
computer (either servers or workstations), the configuration is called a UPS group.
The one computer in the UPS group that is physically attached to the UPS
communications cable is called the UPS group controller. All other computers
powered by the UPS are called group members.

Wink. A brief interruption of utility power caused either by a blackout, a brownout, or
a surge condition.



Wink Time. The number of seconds after a utility power failure that the software waits
to inform you that the system will be shutting down. This delay eliminates nuisance
messages from brief power interruptions.

Workstation. A computer running DOS, Windows, Windows 95, Windows NT or
OS/2. In Windows NT, the domain controller and other servers run Windows NT
Advanced Server. See Requester.



Send any comments about this product to
info@email.exide.com

Send any comments about this manual to
 sshepard@email.exide.com


	S E C T I O N 1
	LANSAFE III AND FAILSAFE III FOR DATA PROTECTION
	N e w F e a t u r e s f o r Ve r s i o n 4
	P e r i o d i c L o g f o r F a i l S a f e I I I a n d L a n S a f e I I I
	T C P / I P S u p p o r t f o r L a n S a f e I I I
	S N M P S u p p o r t f o r L a n S a f e I I I
	N e t F i n i t y S u p p o r t f o r L a n S a f e I I I


	S E C T I O N 2
	INSTALLATION
	S y s t e m R e q u i r e m e n t s
	I n s t a l l a t i o n G u i d e l i n e s f o r La n S a f e I I I
	Supported Operating Systems and Protocols Novell-DOS-Windows-OS/2-Macintosh
	Supported Operating Systems and Protocols UNIX Systems

	G e n e r a l In s t a l l a t i o n Pr o c e d u r e s
	S t e p 2 i f I n s t a l l i n g L a n S a f e I I I f o r U N I X
	To Install LanSafe III with Dry-Contacts UPSs
	I n s t a l l t h e D e v i c e D r i v e r P r o m p t

	P o s t I n s t a l l a t i o n
	S t a r t i n g t h e P o w e r M o n i t o r
	T e s t t h e S o f t w a r e

	M i s c e l l a n e o u s Pr o c e d u r e s
	C r e a t i n g F l o p p y D i s k s f r o m a C o m p a c t D i s k
	T o R e i n s t a l l L a n S a f e I I I o r F a i l S a f e I I I
	R e m o v i n g L a n S a f e I I I f o r U N I X


	S E C T I O N 3
	OPERATION
	N o r m a l O p e r a t i o n s ( G r e e n I c o n )
	B a t t e r y O p e r a t i o n s ( Y e l l o w Ic o n )
	P o w e r M o n i t o r M e s s a g e s f r o m O t h e r N e t w o r k N o d e s

	E m e r g e n c y Op e r a t i o n s ( R e d Ic o n )
	T h i n g s t o R e m e m b e r A b o u t R u n n i n g t h e S o f t w a r e
	T h i n g s t o R e m e m b e r A b o u t U P S s w i t h D r y - C o n t a c t I n t e r f a c e s
	U n d e r s t a n d i n g U P S Gr o u p s
	U P S G r o u p T e r m i n o l o g y
	U P S G r o u p C o m m u n i c a t i o n s R e q u i r e m e n t
	T h i n g s t o R e m e m b e r A b o u t L a n S a f e I I I i n a U P S G r o u p

	C o m m u n i c a t i o n s Se t u p
	T o C h a n g e C o m m u n i c a t i o n s P o r t s
	T o R u n t h e C o n s o l e

	M o n i t o r i n g a Po w e r En v i r o n m e n t
	T o S e l e c t I n p u t a n d O u t p u t P h a s e s f o r V i e w i n g
	T o C h a n g e C o n s o l e V i e w s
	T o S e l e c t A n o t h e r N o d e t o M o n i t o r ( L a n S a f e I I I )

	V i e w i n g t h e Lo g s
	T o A c c e s s a L o g
	T o E n a b l e t h e P e r i o d i c L o g
	T o E s t a b l i s h P e r i o d i c L o g S e t t i n g s

	S y s t e m Co n t r o l F e a t u r e s
	T o S e l e c t a L a n S a f e I I I N o d e t o C o n t r o l
	T o C o n t r o l a N o d e w i t h A n o t h e r L a n S a f e I I I A c c e s s C o d e
	T o C h a n g e t h e L a n S a f e I I I A c c e s s C o d e f o r a N o d e
	T o C h a n g e t h e L a n S a f e I I I A c c e s s C o d e f o r a N e t w o r k
	T o C o n f i g u r e t h e N e t w o r k U P S A c c e s s C o d e f o r a U P S G r o u p

	D i a g n o s t i c s Ta s k s
	T o S e t U p a M a i n t e n a n c e R e m i n d e r
	T o T e s t H a r d w a r e f o r N e t w o r k ( L a n S a f e I I I )
	T o R u n P r e v e n t i v e M a i n t e n a n c e

	A l e r t R e s p o n s e
	T o R e c o n f i g u r e S h u t d o w n T i m i n g
	T h i n g s t o R e m e m b e r A b o u t S h u t d o w n T i m i n g

	C u s t o m i z i n g A l e r t s
	T o C h a n g e t h e T e x t f o r a M e s s a g e
	T o E x e c u t e a C o m m a n d w h e n a n A l e r t O c c u r s
	T o S e n d E - M a i l
	T o S e n d a S t r i n g t o a M o d e m
	C r e a t i n g a m o d e m s t r i n g
	T o S e t a D e l a y T i m e f o r a n A l e r t M e s s a g e
	T o S e n d B r o a d c a s t M e s s a g e s t o L o g g e d - O n U s e r s ( L a n S a f e I I I )
	T o S e n d N e t F i n i t y A l e r t s

	R o u t i n e Sh u t d o w n s
	T o U n l o a d t h e P o w e r M o n i t o r ( L a n S a f e I I I )
	T o S h u t D o w n a n d R e b o o t t h e S y s t e m
	T o S h u t D o w n a L o a d S e g m e n t o n a S c h e d u l e d B a s i s

	L o a d Sh e d d i n g
	T o C o n f i g u r e L o a d S e g m e n t s
	T o S h o r t e n a S h u t d o w n D e l a y
	T o D e l a y R e s t a r t o f a L o a d S e g m e n t
	T o S e t a R e s t a r t D e l a y
	T o D e l a y R e s t a r t o f N o n - E s s e n t i a l P e r i p h e r a l s

	A c c e s s i n g th e H e l p Sy s t e m
	T o C h e c k t h e S o f t w a r e V e r s i o n

	A l t e r n a t e Co n s o l e St a r t u p Me t h o d s
	T o M o n i t o r L a n S a f e I I I o n A n o t h e r N o d e
	T o C o n t r o l L a n S a f e I I I o n A n o t h e r N o d e
	T o C o n t r o l a N o d e i n a G r o u p W h o s e A c c e s s C o d e s D i f f e r f r o m Y o u r s
	T o L i m i t Y o u r B u i l d t o S p e e d N e t w o r k P o l l i n g


	S E C T I O N 4
	UNIX TEXT-BASED ENVIRONMENT OPERATION
	T o St a r t th e La n S a f e II I Co n s o l e f o r Yo u r O w n N o d e
	T o S t a r t L a n S a f e I I I a n d S e l e c t a N o d e O t h e r t h a n Y o u r O w n t o V i e w o r C o n t r o l
	C o n f i g u r i n g La n S a f e II I
	T o C l o s e t h e S c r e e n a n d R e t u r n t o t h e M a i n M e n u
	T o E n t e r a N e w C o m m u n i c a t i o n s P o r t
	T o S c h e d u l e M a i n t e n a n c e
	T o C o n f i g u r e S h u t d o w n T i m i n g
	T o C h a n g e t h e A c c e s s C o d e
	T o S a v e a n y S e t t i n g C h a n g e s Y o u H a v e M a d e
	T o C a n c e l a n y C h a n g e s a n d R e s t o r e t h e D e f a u l t s
	R u n n i n g a H a r d w a r e T e s t o r P r e v e n t i v e M a i n t e n a n c e
	S h u t t i n g D o w n o r R e b o o t i n g t h e W o r k s t a t i o n

	M o n i t o r i n g a P o w e r E n v i r o n m e n t
	T o U p d a t e t h e L i s t , o r t o C l o s e I t
	E x p o r t i n g L o g F i l e s

	A P P E N D I X A
	TROUBLESHOOTING
	A P P E N D I X B
	GLOSSARY

